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2. Introduction 
 

 

This document contains all of the information needed to install, set up, and run the American Miniature Horse 
Association Show Program.  The major categories are as follows: 
 
 
How Do I Get Started? 
 
How Do I Get To Know The System? 
 
How Do I Set Up A Show For The First Time? 
 
How Do I Manage My Entries During A Show? 
 
How Do I Enter Results? 
 
How Do I Manage Things After A Show? 
 
How Do I Get Ready For The Next Show? 
 
How Do I Print Listings? 
 
How Do I Manage Database Repair/Maintenance? 
 
Is There Anything Else I Need To Know? 
 
I Need Help 
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3. How Do I Get Started? 
 

 

In order to use the Show Program, you first have to obtain the Show Program.  This is easily done with a 
phone call to the American Miniature Horse Association office.  Soon after doing this, you will receive an email 
with a link and password where you can download the setup program.  Complete details on downloading and 
installing the program are in the document "'Installing the AMHA Show Program.pdf'. 
 
Note:  This document is an abridged version of the entire documentation file called “AMHA Show Program”.  
The program is capable of much more than this start-up guide illustrates.  Once you’re comfortable with the 
basic working of the program, please browse the entire documentation file for more information. 
 
 

3.1. Running The Program 
 

 
The installation program will have created shortcuts on the desktop and the start  menu.  Double click on the 
shortcut to start the program.  You should see something like this: 
 

 
 
 
 
At this point, you will want to select the folder for the show you're working on.  Even though we only show 
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one show here ("My first show"), you can and probably will have multiple folders, one for each show. 
 
Double click on the "My first show" folder.  Your screen should now look like this: 
 

 
 
Now, click the "Select database location" button and it will take you to the main splash screen: 
 



 6 

 
 
 
 
 
Pretty plain, isn't it?  It's time to make it look like yours! 
 
How do I set up a show for the first time? 
 
 

4. How Do I Get To Know The System? 
 

 

4.1. Locating Records 
 

 

There are two methods of looking up data in the various entry screens.  The first is a search, and is indicated 
by a small button with a blue “S” next to the field it’s available for, as follows: 
 

 

 

Search button 

Click this button to activate the search. 

 
Clicking on this button will display another screen, asking for the ID, class number, etc. you wish to search for.  

 
 

 
The purpose of a search is to position yourself on a particular record.  If, for example, you wanted to go 
directly to class number 12345, you would click on this button, enter the value in the screen that appeared, 
and click “OK”. 
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The other method of looking up data is a “find”, and is designated by a button with a pointing hand on it, as 
follows: 
 

 

 

Find button 

Click this button to activate the search.  

 
 

 

The purpose of this type of button is to give you choices when filling a field.  For example, you have just 
entered a new horse, and need to input the owner Id.  If you don’t know the Id, you can click on the “find” 
button, which will present you with a screen of owners that you can choose from.  Choosing an owner from 
this screen fills in the appropriate Id number in the field you were working on. 
 
 
 
 
There is an additional filter available on the owner screen.  The top of the first tab of the owner screen looks 

like this: 
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5. How Do I Set Up A Show For The First Time? 
 

 

The best way to begin a new show is to proceed in this order: 
 

1. Enter your Administrative information for the show 

2. Enter your classes 

3. Enter your owners/members using the Owner entry screen (File-Owners).  Fill in all information 
pertinent, including the checkboxes for handler, trainer, owner, etc.  You will only use the first page of 
the owner screen in this step.  

4. Enter your horses using the Horse entry screen (File-Horses/Ponies).  Fill in all pertinent information , 
including the height, sex, birthdate, and foundation number if applicable.  There are some built in edits 
in the system that can cause you problems down the road if you don’t fill these fields in.   

5. Enter your entries, see How do I make entries? 

6. Enter and assign your judges, see How do I manage judges tasks? 

7. Print whatever listings are needed for the show 

 

 

5.1. Administrative Work First 
 

 

Customizing the System 
 
How to log in to the Show Management Administration Screen 
 
How to add the show name and the type of show to the splash screen 
 
How to customize owner accounting data 
 
How to use the system's accounting feature 
 
How to use the system's security feature 
 
How to set the system's auto-edit function 
 
 

Backing Up, Restoring, and Initializing Data 
 
Making a backup 
 
Automatic backup 
 
Restoring data 
 
Initializing data 
 

5.1.1. How Do I Customize The System? 
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There are multiple ways in which you can customize this system.  They are: 
 

• Customize the splash screen and the titles on the various entry screens, see Adding The Show Name 
And Type Of Show 

• Customize the accounting data on the Owner Screen, see Customizing Owner Accounting Data 

• Use the system's internal Accounting Feature 

• Customize the system's internal password protection, see Using the Security Feature 

• Set the system's Auto-Edit Function 

• Import owners and horses from the office (optional) 

• Import previously used classes or show information into your current show. (see the NOTE at the 
bottom of Making A Backup) 

 

All of these features can be ultimately controlled by logging in to the Show Management Administration 

Screen.  

 

 

5.1.1.1. Logging In To The Show Management Administration Screen 
 

 

Click on the “File” option on the top left.  Choose the “Administration” option, then choose “Show 
Management Screen”. 
 

 
 

 

The following screen will appear: 
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Click this button first 

You will then be prompted for a password. Enter the password you have been given, and click "OK". 

 

 

 

You will now see the previous screen, only with data in it. You are now logged in.  

 

5.1.1.2. Adding The Show Name And The Type Of Show 
 

 

By default, the splash screen (the first screen you see when you activate the system) looks like this: 
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You can customize the show name (first line at the top left, above “File-Reports-Tools-Help”), and the two 
large lines that appear on the main portion of the screen.  For example, we can customize this screen to 
appear as follows: 
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To customize the splash screen, perform the following steps: 

1. Activate the system by double-clicking the system icon on your desktop, or by searching for the 

program “EQUIENTRAMHA.EXE” and double-clicking it. 

2. Log in to the Show Management Administration Screen. 

3. To modify the splash screen, you will change the top three edit boxes: 

 

 

Modify show name 

Modify this line to change the show name information. This field appears on every screen in the system, and in 

the heading of every report. The show name can be up to 30 characters long. 

 

 

 

Modify lines 1 and 2 on splash screen 

Modify these two lines to change lines 1 and 2 on the splash screen. Each line can be up to 20 characters long. 

 

 

 

Type of show checkbox 

Make sure you have the type of show selected. 

 

 

 

Click this button to save and exit 

Once you are satisfied with the verbiage you’ve added and the choices you’ve made, click on this button at the 

bottom right side of the screen to save and exit. 
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Your changes have now been saved, and you are returned to the splash screen.  Since the system reads the 

show name and line values before it displays the screen, you must close out of the system and come back in 

before your changes will be in effect. 

 

5.1.1.3. Customizing Owner Accounting Data 
 

 
The owner accounting data is presented on the “Accounting” tab of the owner screen (File-Owners), and when 
fully implemented, will look something like this: 
 

 

 

Simple fees 

Simple fees are one time charges for a single item.  For example, a sponsorship fee is a simple fee. There are 5 
simple fees that you can customize as you choose. 

 

 

 

Compound fees 

Compound fees are fees where one pays so much for so many items.  For example, if we have to indicate that 
an owner paid five entry fees of $35.00 each, we use a compound fee. There are 17 compound fees, but 8 of 

them are reserved for system use. 
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Checkboxes 

Checkboxes are simple yes/no indicators. You have up to 10 of these fields to customize as you choose.  

 

 

 

Database navigator 

For more information on using the database navigator click here. 

 
 

 

 

 

How to modify the accounting page 

To modify the accounting page (and the associated reports), log in to the Show Management Administration 

Screen. 

It should look like this:  
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Click the bottom middle button to display the accounting screen, and it should bring up the following screen: 
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"Reminder" checkboxes 

You can have up to 10 "reminder" checkboxes on the accounting screen.  To activate them, simply type in the  
description for the checkbox, such as "paperwork checked", "fees paid", etc.  If you do not wish to use a 

particular checkbox, simply leave it blank or "Not Defined'. 

 

 

 

Single fee boxes 

You can have up to 5 "single fee" boxes.  These would be used for things like sponsorships, advertising, etc.   

They are used to accept a single amount of money.   If you do not wish to use a particular single fee, simply 
leave it blank or "Not Defined'. 

 

 

 

Compound fee boxes 

There are 15 "compound" fees (fees where you have so many items at a fixed price), but some are reserved for 
various entries.  

  
Hover your mouse over the fields to see if they are supposed to be assigned a particular value.  The reserved 

fields are highlighted in yellow.  Examples would be various types of entries, stall fees, shavings, etc.  If you do 
not wish to use a particular fee, simply leave it blank or "Not Defined'. 

 

Please do NOT try to use the predefined fields for anything other than what they are labeled for. 
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Process updates Button 

Click this button to save your updates.  

 

 

 

Close/cancel Button 

Click this button to exit the screen. 

 

 

 

 

5.1.1.4. Using The Accounting Feature 
 

 

 

You have the option of maintaining all of the owner accounting information mentioned above manually, or 
having the system maintain it for you. Maintaining it manually means that you enter the correct amount into 
the accounting fields defined above. This means, for example, that you would be responsible for entering the 
correct number of open entries into the proper accounting field.  
 
To turn this on and off, log in to the Show Management Administration Screen and find the checkbox in the 

upper right hand corner that says "Use the system's built in accounting feature" as follows: 
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Built-in accounting feature checkbox 

To enable the accounting feature to have the system do this maintenance for you, simply check this 
box. To turn off this option, uncheck this box. 

 
 

 

It works like this: When the “use the system’s built-in accounting feature” checkbox is checked, some of the 

compound fee fields are reserved for the system as follows: 

1. Compound fee #1 is reserved for Open classes. 

2. Compound fee #2 is reserved for Amateur classes. 

3. Compound fee #3 is reserved for Youth classes. 

4. Compound fee #4 is reserved for COOL classes. 

5. Compound fee #5 is available for use. 

6. Compound fee #6 is reserved for Futurity. 

7. Compound fee #7 is reserved for one Futurity. 

8. Compound fee #8 is available for use. 

9. Compound fee #9 is available for use. 

10. Compound fee #10 is available for use. 

11. Compound fee #11 is reserved for  Gelding Incentive. 

12. Compound fee #12 is available for use. 

13. Compound fee #13 is available for use. 
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14. Compound fee #14 is available for use. 

15. Compound fee #15 is available for use. 

 

Whenever an entry into a class is made, the system looks at the class chosen, and determines which of the 

above criteria is met by inspecting the checkboxes, as shown below: 

 

 

Class selection checkboxes 

One of these checkboxes must be checked for the internal accounting to function properly.  If you add classes 
from the master class list, these checkboxes are already set.  If you add a class of your own, you will be forced 

to check on of the boxes. 

 

 

 

NOTE: It is not recommended to change your use of the internal accounting feature once you have started 

making entries. 

 

NOTE: If there are classes that you do not want to charge for (such as championship classes), be sure to 
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check the “No charge” button on the class screen.  This will keep the class from getting charged even if you 

are using the internal accounting feature. 

 

 

5.1.1.5. Automatic Backup 
 

 
In addition to performing backups by using the “Backup tables” option under the “Tools” menu, you can set 
the system to perform automatic backups. This is particularly useful when making entries.  Automated 
backups run every 15 minutes. To enable the function, log in to the Show Management Administration Screen. 
 

 

 

Enable auto-backup checkbox 

Check this box to enable the automatic backup function.  

 
 

 

Specify number of backups to keep 

Enter a value here to specify how many backup copies should be maintained at one time. It is recommended 

that you keep at least 10 copies. You can keep up to 100 backups.  

 
 

 

Backups occur every 15 minutes, and are stored in a subfolder called “System backups”, which is found in 

your show program folder.  The files themselves are timestamped, and look like this:  “aspcdata-07-09-2018 

16-18-06.mdb”. 

 

 

5.2. How Do I Enter My Classes? 
 

 

A database of office classes has been defined for the use of office staff, which corresponds to the classes in 
your show. These office classes already have all of the proper selections made, dropdown lists populated, etc.  
You may use any of these classes and assign them their own specific show class number.  To do this, proceed 
as follows: 
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1. Navigate to the class screen by choosing "Classes" under the "File" menu.  

 

 

First, click the plus to insert a new record 

For more information on using the database navigator click here. 

 

 

 

Second, enter your class number 

After you click the plus, enter your class number. 

 
 

 

Third, search for your office class number 

Click the "S" to the right of "Office class #" to search an office class. Enter the name of your class and then click 
"Select". 

 
 

 

 

5.3. Entering Your Classes From A Spreadsheet 
 

 
Version 6.4 introduced the capability of creating your class records from a spreadsheet, rather than having to 
type them all in.  To do this, click on the “Import classes from spreadsheet” button in the toolbar on the Class 
Entry Screen (File-Classes). NOTE: Importing classes in this manner will overwrite any classes you 
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have already entered. 
 

 
 

 

Clicking the button will bring up a dialog box asking you to select your spreadsheet, as follows: 
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Once you select your spreadsheet and click “Open”, a screen similar to this will appear, displaying your 

spreadsheet: 
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You now need to tell the program where your “go numbers” are, and where your office class numbers are.  

Remember that the top row, and the leftmost column are number 0, not 1.  In the example above, the column 

that has the “go number” would be column 0, the master class numbers would start in column 1, and the row 

where the data starts would be row 0 (the top one). 

Once this has been decided, you will click the “Proceed with import” button.  Messages may be displayed in 

the memo area in the middle of the screen.  These messages usually are indications of errors, such as a 

master class in the spreadsheet not matching what you have in your master class database.  These classes 

will have to be added by hand, as will non-rated classes that don’t have a master class assigned to them. 

 

5.4. Entering sponsorship information 
 

 
Sponsorship information for sponsored classes can be entered in two different ways: 
 

1. Go to each individual class and type in the sponsorship information. 
2. Import the information from an Excel spreadsheet. 

 

5.4.1. Importing sponsorship information from a spreadsheet 
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If your sponsorship information is in a spreadsheet, it is a simple matter to use it to update your class list with 
the sponsorship information. 
 

 
 
Clicking this menu item will bring up a dialog box asking you for your speadsheet: 
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Entering or searching for your spreadsheet and clicking the "Open" button will cause the following screen to 
appear: 
 

 
 
Clicking "Open" brings up the following screen: 
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You now have to tell the program where to start.  Follow the directions on the screen.  In this case, my filled 
in screen would look like this: 
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Clicking the "Proceed with import" button gives us this: 
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Now, if we were to inquire class number 1, we'd see the following: 
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Processing results 

This area tells us if the import works or not 

 

 

 

 

File name box 

This where your excel spreadsheet name goes. 

 

 

 

5.5. How Do I Enter Owner Information? 
 

 

Under the "File" menu, go to "Owners" to get to the main owner information screen: 
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You can manually enter them using the database navigator. For more information on using the database 
navigator, please click here.  
 

 

 

Database navigator 

For more information on using the database navigator click here. 

 
 

 

Entry Information tab 

For more information please click here. 

  

 

Accounting tab 

For more information please click here. 

  

 

Classes entered as exhibitor tab 

For more information please click here. 

  

 

Classes entered as trainer tab 

For more information please click here. 
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5.5.1. Looking Up Owner Information From The Office 
 

 

 

Version 6.2 introduced the ability to update horse or owner/member information directly from an online copy 
of the Office Pedigree Database.  This eliminates the need to do a complete download and import when only a 
small amount of data is needed.  In order to use this functionality, establishing a connection to the remote 
office database is necessary.  This is accomplished from the main splash screen: 
 

 

 

This function is offered in two ways: 

1. When searching by Id/Registration number for a horse or owner, an option will be displayed in the case of 

an unsuccessful search.  This option will look like this: 

 

Clicking “Yes” will cause the online owner file to be searched for the owner record.  If found, the owner record 

will be added to the local database. 
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2. When displaying a record on the corresponding entry screen (File-Owners), updating can be initiated by 

clicking on the “Update from remote database” button on the toolbar: 

 

 

Update from remote database button 

You must be logged in to the remote office database for this button to appear. 

 
 

 

Checkmark will then appear to show all information is updated 

You must click the "Update from remote database" button first, then this checkmark will appear to show 
updating is done.  

 
 

 

 

5.5.2. Entry Information 
 

 
The second tab on the main owner entry screen (File-Owners) is "Entry Information":  This screen displays all 
entries that this member/entity is fiscally responsible for. 
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Database navigator 

For more information on using the database navigator click here. 

 
 

 

 

 

5.5.3. Accounting 
 

 

The third tab on the main owner entry screen (File-Owners) is "Accounting":  If you are using the system's 
built-in accounting feature, this screen will show the results of entries made, scratches processed, etc.  This is 
also where payments received are recorded. 
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Checkboxes 

This is where your custom checkboxes are displayed. 

 

 

 

Single fees 

This is where your "single fee" items are displayed. 

 

 

 

Compound fees 

This is where your "compound fees" are displayed.  If you are using the accounting feature, any entries or 
scratches are automatically reflected here. 
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Payments grid 

This is where payments will appear. 

 

 

 

Post changes to accounting 

Clicking this button will save your accounting data. 

 
 

 

Print statement 

Clicking this statement will print a statement for the displayed member/entity. 

 
 

 

Refresh charges 

Click this button to recalculate the accounting charges.  This can be useful after performing several scratches, 

adds, etc. 

 
 

 

 
For more information on how to modify the accounting page, please see "How to modify the accounting page" 
under  Customizing Owner Accounting Data. 
 
 
 

 

5.6. How Do I Enter My Horses? 
 

 

Under the "File" menu, choose "Horses/Ponies" to get to the Horse/Pony Information Screen: 
 
This is the main entry screen for horses.  You can manually enter them using the database navigator. For 
more information on using the database navigator, please click here.  
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Database navigator 

For more information on using the database navigator click here. 

 
 

 

 

 

5.6.1. Looking Up Horse Information From The Office 
 

 
This program has the ability to update horse or owner/member information directly from an online copy of the 
Office Pedigree Database.  This eliminates the need to do a complete download and import when only a small 
amount of data is needed.  In order to use this functionality, establishing a connection to the remote office 
database is necessary.  This is accomplished from the main splash screen: 
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This function is offered in two ways: 

1. When searching by Id/Registration number for a horse or owner, an option will be displayed in the case of 

an unsuccessful search. This option will look like this: 

 

Clicking “Yes” will cause the online files to be searched for the horse record. You must specify the registry that 

you want to be searched for a matching registration number. If found, the horse will be added to the local 

database. 

2. When displaying a record on the corresponding entry screen (File-Horses/Ponies), updating can be initiated 

by clicking on the “Update from remote database” button on the toolbar: 
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Update from remote database button 

You must be logged in to the remote office database for this button to appear. 

 
 

 

Checkmark will then appear to show all information is updated 

You must click the "Update from remote database" button first, then this checkmark will appear to show 
updating is done.  

 
 

 

Owner search button 

Click this button to go to the name search screen to be able to search an owner/member name from the office 

database. See below.  

 
 

 

When searching for an owner/member name on the Horse/Pony Information Screen, you can search the office 

database by clicking the button displayed on the name search screen (from the owner search button): 
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Search Office database Button 

Write description here... 

 

 

 

 

 

 

5.7. How Do I Make Entries? 
 

 
There are two ways of making entries in the system: 
 
Standard entries 

Expedited entries 

 

 

5.7.1. Entries - Standard 
 

 

Standard entries are made by clicking on the “add record” button of the navigator bar of the Entry screen 
(File-Entries). To make an entry, you must first designate the person responsible for the bill. To do this, first 
click the button on the top that says "click to add or update" (to the right of "person responsible for 
payment").  
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First, designate the person responsible for the bill 

To make an entry, you must first designate the person responsible for the bill. To do this, click the button that 

says "click to add or update". 

 

 

 

Add record button 

Clicking here presents a blank screen for you add a new record. For more information on using the database 

navigator click here. Before you can make an entry, however, you must designate a person responsible for 

payment. 

 
 

 

Scratch dropdown 

Click this button to scratch or unscratch the displayed entry.  Click here for more information. 

 
 

 

Back number search button 

Use this button to search for a particular back number. 

 
 

 

Entry grid 

This is just a table view of all of your entries.  Clicking on one will cause it to be displayed above.  Clicking the 
"Only show entries in grid for selected back number" will restrict the grid to only entries for the displayed back 

number. 
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In order to streamline the entry process, additional options were added to the toolbar by the navigator 

bar. These buttons allow you to: 

1. Add a horse to another class - Once you have filled in all of the necessary information for the first 

entry and saved it, clicking on this button will start a new entry and fill in all of the previously entered 

information except for the class number. 

2. Add more team horses to an entry - When making team entries, enter one of the horses completely 

(including checking the “team entry?” checkbox), and save the record.  You will then click on the “Add 

more team horses to an entry” button.  This will start a new entry record, bringing the class 

information and back number forward, allowing you to choose the next horse.  It is very important 

that you use this button when making team entries.  Using this button sets some indicators on 

the team records which allow the class sheets to print properly. 

3. Assign a back number to this horse - Once you have made all of the entries for a particular horse, you 

can click this button to assign a back number if you have not already done so.  Clicking this button 

brings up the following screen: 

 

 

Fill in the back number, and click “OK” to assign the back number to all entries for this horse. 

 

 

5.7.1.1. Scratching/unscratching an entry 
 

 

To scratch or unscratch an entry, go to the Entry screen (File-Entries) and use the dropdown menu in the 
upper right corner: 
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To scratch/unscratch a horse use this dropdown menu 

For more information on the types of scratches, click here. 

 

 

 

 

 

5.7.1.1.1. Types Of Scratches 
 

 
These are the types of scratches: 
 

• Office scratch - When someone contacts the office and announces their intention to scratch an entry. 

  This will result in the refunding of the entry fee. 

• Gate scratch - When someone announces at the gate they are not going to show. 
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  This will result in the forfeiture of the entry fee (i.e. they still get charged for the entry). 

• No show - This is typically not used by AMHA. 

 
NOTE: NO SHOWS ARE MAINLY USED AT REGIONALS AND WORLDS 
 
 
 
 
 

5.7.2. Entries - Expedited 
 

 

The second way of making entries is to use the “Expedited entry” option under the "File" menu.  Choosing this 
option brings up the following screen: 
 

 
 
This screen is a combination of an entry screen, the horse entry screen, and the owner screen.  A “splitter” 

down the screen lets you show more or less of the screens by dragging it left or right. 

This screen allows you to make multiple entries on one screen.  You can choose from multiple exhibitors, and 

can assign financial responsibility for all charges.  This screen is useful when using the internal accounting 

system because you can make entries for office fees, stall/tack fees, late fees, etc. 

 

5.8. How Do I Manage Judges Tasks? 
 

 

Judges tasks can be completed by choosing "Judges Maintenance" from the Administration option under the 
"File" menu, as follows: 
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Choosing the “Judges Maintenance” menu item will display the following screen. First, hit the "Authenticate" 

button and enter your password to log in.  
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Authenticate button 

Be sure to click this button first to log in by entering your password. 

 
 

 

Database navigator 

Use this to add judges. You may have as many judges as you wish. For more information on using the database 

navigator click here. 

 
 

 

Judge ID number 

Each judge should have an Id associated with them. This number may be an actual assigned number, or you can 

simply start with 1 for the first judge, and continue.   
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Assign classes to selected judge button 

For more information please click here. 

 
 

 

Clear judges from classes button 

Use this to clear the judges from all classes. For more information please click here. 

 
 

 

View class database button 

For more information please click here. 

 
 

 

Display classes for selected judge button 

Check to see what classes are assigned to a judge. For more information please click here. 

 
 

 

View class with no judges button 

Look for classes that have not had a judge assigned to them. For more information please click here. 

 
 

 

Assign call judges button 

To assign a call judge, click this button.  The system will look for any classes with three judges, and rotate the 

call judge between the three. To see the message you will get when this task is completed please click here. 

 
 

 

 

5.8.1. Assign Classes To Selected Judge 
 

 

Once your judges are entered (by using the database navigator at the top of the page, for more information 
please click here), you can assign them to your classes.  To do this, click next to the desired judge in the 
space on the left hand column to highlight the judge, as follows: 
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With the desired judge highlighted, click the “Assign classes to selected judge” button. NOTE: If this option is 

not available please authenticate by clicking the "Authenticate" button at the top of the screen and entering 

your password. The following screen will appear: 

 

 

Class range 

Enter the class range that you wish to assign the judge to. 

 

 

Indicate what number the judge is going to be in the class 
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 Example: first judge, second judge... 

 
 

 

OK button 

Click to complete assignment 

 
 

 

Cancel button 

Click to exit the screen 

 
 

 

 

5.8.2. Clear Judges From Classes 
 

 

When clicking "Clear judges from classes", you will get the following screen. NOTE: If this option is not 
available please authenticate by clicking the "Authenticate" button at the top of the screen and entering your 
password. 
 

 
 
 
You can also clear judges from classes by using the Initialization routine. 
 
 
 
 

5.8.3. View Class Database 
 

 

When clicking "View class database", you will get the following screen: 
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You have the option of printing standard or alternate-format judges’ cards from this screen.  The cards will 
print with the judge’s name on it, and will designate whether or not the judge is serving as a call judge. Click 
here for samples of judges cards. 
 
 

5.8.4. Display Classes For Selected Judge 
 

 

Beginning with version 5.9, you are now able to print judges’ cards from the judges maintenance screen.  
From the judges maintenance screen, choose the “Display classes for selected judge” option (make sure you 
have selected your judge).  You will see the following screen: 
 

 
 
 
You have the option of printing standard or alternate-format judges’ cards from this screen. The cards will 

print with the judge’s name on it, and will designate whether or not the judge is serving as a call judge. Click 

here for samples of judges cards. 

 

5.8.4.1. Sample Judges Cards 
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Standard judges cards look like this: 
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Alternate judges cards look like this: 
 

 
 
 

5.8.5. View Class With No Judges 
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When clicking "View class with no judges", you will get the following screen. If judges have been assigned to 
all classes this screen will be empty.  
 

 
 
 
 
 
 

 

6. How Do I Manage My Entries During A Show? 
 

 

How to scratch or disqualify an entry 
 
How to split large classes 
 
How to promote entries to another class 
 
How to scramble the order of go 
 
 
 

6.1. Scratching Or Disqualifying An Entry 
 

 

There are a couple of ways to scratch an entry.  
 
The first is by going to "Entries" under the "File" tab. You will see this screen: 
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Find the "scratch this horse" dropdown menu in the upper right corner. This will give you the option of an 
office scratch, a gate scratch, or a no show. If a horse is scratched on accident, simply click "undo". For more 
information on the types of scratches click here. 
 
 
 
The other place you can enter a scratch or disqualification is on the "Record judging and who showed" screens 
under the "Tools" tab.  
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Find where it says "Change Entry Status" in single judge/multiple judge placing: 
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Here you will be given these options:  
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7. How Do I Enter Results? 
 

 

There are two ways that placings can be recorded in the system: 
 

1. Directly on the entry screen for the placing horse, see The Old Fashioned Way 

2. Using the utility which allows you to enter all of the placings for a particular class either with a single 
judge score of multiple judges scores 

 

7.1. The Old Fashioned Way 
 

 
Once you locate a particular entry that has placed in a class, you may edit the entry directly on the entry 
screen (File-Entries).  
 
Example:  Registration number A199176 has won 2nd place in class 11.  We want to record the placing.  We 

would first locate the entry: 
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We would then enter an 2 in the placing field, and then save the record by clicking on the checkmark in the 

database navigator bar at the top of the screen. For more information on using the database navigator please 

click here. 

This method of entry can be used anytime on any entry. It can be used to correct mistakes as well as 

performing the initial entry. This is a slow and tedious way to record placings, however. 

 

7.2. Single Judge Score 
 

 
The best method of entering placing values would be to use one of the utilities provided by the system under 
the “Tools” menu item.  For classes utilizing one judge scoring, the entry screen you want to use to record the 
placings is labeled as “Record placings and who showed”. 
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This will bring up a screen that looks like this:  
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This screen allows you to enter up to 10 placing values for a particular class.  (If you have more than 10 

placings, you would enter the first 10, post them, and then clear the screen).  You would enter the class 

number, and then the back number and the placing associated with the back number. 

If you are recording information on entries that showed in the class but did not place, you can enter their back 

number and leave the placing field blank.   

Once all of your entries have been entered, click on the "Post" button to save them. 

 

 

 

7.3. The best way to enter multiple judges scores 
 

 

For classes allowing multiple judge placing, you will want to use the one that says "Post results for multiple 
judges".  This serves as a replacement for the 
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“Record placings and who showed (multiple judges)” option, although that option remains available. 
 

 
 

This will display a screen like this: 
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The idea of this screen is that you can see all of your judges scores at once, thus cutting down on missing 

results.  Once you enter your class number and press the "Enter" key, you will see something like this: 

 

 

 

Class number field 

Enter your class number that you want to post results for here. 
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Back number grid 

This is where the back numbers/results appear after you leave the class number field.  In this example, judge 1 

has 10 results entered. 

 

 

 

Post button 

Click this button to save your results. 

 

 

 

Duplicate these entries 

If all of the judges have scored the class identically, you can enter the results for judge 1, click this button, and 

then click the Post button.  The system will automatically fill in the remaining judges scores for you. 

 

 

 

7.4. Three Judge Average Score 
 

 
This scoring method involves capturing the scores of three separate judges and combining their scores to 
determine the placings.  The entry screen looks like this: 
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The Prepare button 

Before a class can be scored, it must be prepared.  You do this by clicking the "Prepare this class for judging" 
button.  The following screen will appear: 

 
 

Enter your class number in the box, and click the "OK" button. 
 

Caution:  If when preparing your class, you receive a message indicating that the class has already been 
prepared, use caution.  If you accidentally prepare a class after it's been judged, you will erase the judging 

records for that class.s 
 

 

 

  

 

The Calculate button 

Once all of your scores have been entered, you must calculate the placings.  you do this by clicking this button.  

To see a sample of this screen, click here. 



 65 

 

 

 

The post button 

Clicking this button saves your results.  It is the same as answering "Yes" to the prompt shown in the 

screenshot above. 

 

 

 

Options 

These options help to streamline the judging process.  For example, at the World show, the ring announcer has 
a monitor which displays the announcers report which he/she uses to announce the winners.  By clicking the top 

two options, the report will automatically appear on the screen after results are posted.  If these options are not 
chosen, the ring secretary will have to manually print the announcers report. 

 

 

 

 

 

 

 

 

 

 

The scoring method used is as follows: 
 
1st place - 10 points 
2nd place - 9 points 
. 
. 
5th place - 6 points 
. 
. 
. 
10th place - 1 point 
 
 
 

7.4.1. Screen with scores 
 

 

Before calculation: 
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After clicking the "calculate scores" button: 
 

 
 
 
You can see the scores on the right hand side of the screen.  The system automatically prompts you to save 
your results.  Unless you see a problem, click "Yes" 
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8. How Do I Manage Things After A Show? 
 

 

1. Check the results 

2. Error listings 

3. Prepare and send results to the office 

4. High points 

 

 

8.1. Error Listings 
 

 

Go to "Print error reports" under the "Reports" tab:  
 

 
 
 
 
There are 3 possible error reports: 
 
1. Print classes/horses with no entries 
 



 68 

 
 
 
 
2. Print judges with no results 
 

 
 
 
 
3. Print classes with no results 
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8.2. Preparing And Sending Results To The Office 
 

 
Show results can now be sent as spreadsheets to the office.  Doing so allows the office staff to import the files 
directly into the Pedigree system without having to manually enter them.  To create these spreadsheets, go to 
the "Tools" menu and choose the option “Create files of results for the AMHA office”.   
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You will see the following screen: 
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Step 1 

Click this first. This creates a file of back numbers. 

 

 

 

Step 2 

Click this after Step 1 is completed. This prepares judges information. While this step does not create a file, it 
performs some functions needed in the next step. 

 

 

 

Step 3 

Click this after Step 2 is completed. This creates a file of results.  

 

 

 

Step 4 

Click this after Step 3 is completed. This creates the youth and amateur high points spreadsheets. 

 

 

Close/Cancel button 
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 Use this button to exit the screen. 

 
 

 

 

1. Click the button labeled “Step 1”.  This creates a file of back numbers. 

2. Click the button labeled “Step 2”.  While this step does not create a file, it performs some functions needed 

in the next step. 

3. Click the button labeled “Step 3”.  When this step completes, you will see the following screen: 

 

This screen gives you the opportunity to review your spreadsheet of results before you email it.  Simply check 

the box that says “Open file” and then click "OK". 

 

4. Click on the “Step 4” button.  This creates the youth and amateur high points spreadsheets. 

5. Email the spreadsheets created (found in your show folder) to the office. 

 

 

8.3. High Points (local shows) 
 

 

Access high points reports by going to "Amateur Reports" and "Youth Reports" under the "Reports" tab: 
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You will then have the choice of listing amateur/youth exhibitors with points by name or by handler/horse. 
 
 
For example, in listing amateur exhibitors with points by name, you will get the following screen: 
 

 

 

First, check this box 

Click here first. 



 74 

  

 

Then click OK 

Click here to proceed to the print preview.  

 
 

 

Cancel button 

Click here to exit the screen. 

 
 

 

 

 

Click here for a sample high points report. 
 
 
 

8.3.1. Sample High Points Report 
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9. How Do I Print Listings? 
 

 

Whenever a report is printed, it is usually sent to a screen preview window so the report may be viewed 
before printing.  This allows for the review of the report for accuracy as well as for selectively printing only 
certain pages of the report. When you are ready to print, you can find the "print" button at the top left corner 
of the screen. Use the "export to file" button to the right if you wish to export the information to a file instead 
of physically printing. It is possible to export to file by using the "print" button as well. See below for more 
information.  
 

 

 

Print button 

Click this button to go to the print dialog box. You can still export to file by clicking this button, please see below.  

 
 

 

Export to file button 

Clicking here will allow you to save and export to a file instead of physically printing. See below for more 

information. 

 
 

 

You will see a dialog box like this when you click the print button: 
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To save your output to a file, click on the “Export” button. This is the same thing you will see if you click the 

"Export to file" button: 

 

 

Clicking on the drop down arrow by “Type” will give you the choices of file types: 
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Drop down arrow 

Clicking here will give you the choices of different file types.  

 
 

 

Choose the file type you want, enter the file name (you can click on the browse button to the right of the file 

name field to browse to a particular folder), and click “OK” to print to file. 

 

 

10. Usage Restrictions 
 

 
This program has been purchased by the American Miniature Horse Association for its use and the use of its 
members in conducting AMHA horse shows.  This software may not be given, sold, or transferred to anyone 
else, nor can an AMHA member utilize this software to run other shows without the express permission of W. 
Mark Anderson Computer Consulting. 
 

 

11. I Need Help 
 

 

If you still need help, please contact me.  I will be glad to walk through things with 
you over the phone, through zoom, or depending on distance, in person. 
 
You can get my contact information from the AMHA office. 


